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IntroductionIntroductionIntroductionIntroductionIntroduction

The Philips Velo™ 500 is a handheld PC (H/PC), a new kind of
computer that you can carry with you and use almost anywhere.
With the Microsoft® Windows® CE operating system and
programs, your Velo 500 allows you to keep track of your
appointments, take files with you, send and receive e-mail,
connect to the World Wide Web, and do much more. This Philips
Velo 500 User’s Manual helps you set up your Velo 500 for the
first time and introduces you to its important features, software,
and optional accessories.

Getting help and informaGetting help and informaGetting help and informaGetting help and informaGetting help and informationtiontiontiontion

There are many sources of help and information about your
Velo 500, the Windows CE operating system and programs,
and Windows CE Services for your desktop computer:

◗ This book, the Philips Velo 500 User’s Manual.

◗ Handheld PC Companion, another manual included with
your Velo 500.

◗ Windows CE Services Help on your desktop computer.

To access Help, click Windows CE Services Help Topics
on the Help menu in the Mobile Devices window.

◗ Philips Mobile Computing Technical Support.

You can reach Philips Technical Support by phone at
888-275-8356 or find answers to common questions on the
Web at http://www.mobile.philips.com/faqs/

◗ Other Windows CE sites on the Web:

The Windows CE page on the Microsoft Corporation Web
site at http://www.microsoft.com/windowsce/

The Philips Velo 500 page on the Philips Web site at
http://www.mobile.philips.com/products/hardware/velo500/
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After you’re familiar with the basic operation of your Velo 500,
you can also access the reminders and procedures on the device.
Windows CE Help and ToolTips are available anytime, so there’s
no need to carry your manual with you.

◗ To access Windows CE Help, tap Help on the Start menu
or tap  on the title bar or toolbar. When you open Help,
you’ll see topics for the application or system component
you are using. To see a list of all the Help contents, tap
Other Help.

◗ Velo 500 programs also provide shortcuts and tips for simple
operations. Keyboard shortcuts for menu commands are
listed on the menus to the right of the commands. To display
keyboard shortcuts for toolbar buttons, tap and hold the
stylus on the button until the ToolTip appears.
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VVVVVelo 500 harelo 500 harelo 500 harelo 500 harelo 500 hardddddwwwwwararararare feae feae feae feae featurturturturtureseseseses

This section describes the location and function of the Velo 500
hardware features.

Stylus

Microphone

Power
button

Latch

Reset button

Recharging indicator light

Alarm indicator lightSerial connection light

FigurFigurFigurFigurFigure I:e I:e I:e I:e I:     VieVieVieVieView of w of w of w of w of VVVVVelo 500 with lid openelo 500 with lid openelo 500 with lid openelo 500 with lid openelo 500 with lid open

RJ-11
phone jack

Record button

FigurFigurFigurFigurFigure 2:e 2:e 2:e 2:e 2:     TTTTTop vieop vieop vieop vieop view of w of w of w of w of VVVVVelo 500 with lid closedelo 500 with lid closedelo 500 with lid closedelo 500 with lid closedelo 500 with lid closed

When you open the lid on your Velo 500, you have access to the
touch screen, keyboard, and other important controls. These
features are discussed in the sections that follow.
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Press the Power button to turn your Velo 500 on and off. If you
go several minutes without working on your Velo 500, it will
preserve your work and suspend itself, shutting off automatically.
Just press the Power button to start working again, right where
you left off.

The three indicator lights on the front of the Velo 500 call your
attention to various events:

◗ The green recharging indicator light  is on while the
Philips Velo Rechargeable Battery pack is being recharged.
The light turns off when charging is complete.

◗ The red serial connection light  blinks when your Velo 500
is connected to a desktop computer running Windows CE
Services and a software connection has been established.

◗ The yellow alarm indicator light  blinks to indicate
an alarm you have set. This light stops blinking when
you tap  to close the alarm’s dialog box or when you
double-tap the alarm icon in the status area of the taskbar.

 
Flash/ROM
Miniature
Card slot

Backup battery
compartment

Main battery
compartment

Connector to
V-Module

DRAM Miniature
Card slot

FigurFigurFigurFigurFigure 3:e 3:e 3:e 3:e 3: Bottom vie Bottom vie Bottom vie Bottom vie Bottom view of w of w of w of w of VVVVVelo 500elo 500elo 500elo 500elo 500

Serial connectorDC jack
IR port

FigurFigurFigurFigurFigure 4:e 4:e 4:e 4:e 4: Side vie Side vie Side vie Side vie Side view of w of w of w of w of VVVVVelo 500 (left side)elo 500 (left side)elo 500 (left side)elo 500 (left side)elo 500 (left side)
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Caring for your Velo 500

Clean the casing of your Velo 500 with a damp cloth. For more
persistent dirt, such as grease or oils, use a damp cloth and a
solution of mild detergent in water. Do not immerse your Velo
500, and always wipe off your Velo 500 with a dry cloth after
cleaning.

To clean the display, use a damp cloth or a premoistened pad
designed specifically for use on computer monitors.

Caution Be sure to turn off your Velo 500 before cleaning the
touch screen.

For extra protection, you may wish to purchase the optional
Velo 500 carrying case. For information about the availability of
carrying cases and other accessories, check the Philips Web site
(http://www.mobile.philips.com/).

PPPPPooooowwwwwering yering yering yering yering your our our our our VVVVVelo 500elo 500elo 500elo 500elo 500

The Velo 500 has two kinds of batteries. The main batteries
power your Velo 500 during normal mobile use or when you
are not using an external power source. The backup battery is
a coin-sized lithium battery that protects your saved data when
the main batteries are depleted or are temporarily removed
(for example, while you replace the main batteries). The backup
battery does not provide enough power to operate your Velo 500,
but it will preserve your data for about 24 hours if no other power
source is available. If you are close to an AC power outlet, you can
connect to the power adapter that is supplied with your Velo 500.

An optional car adapter also allows you to power your Velo 500
from the DC voltage in your car. For information about the
availability of car adapters and other accessories, check the Philips
Web site (http://www.mobile.philips.com/).
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The backup battery

The backup battery was installed at the factory, but must be
activated before it will protect your data.

To activate the backup battery
◗ Carefully pull the plastic tab free from the main battery

compartment, and discard it.

To replace the backup battery
1 Remove the screw from the backup battery door, and

then remove the door.

2 Remove the old backup battery.

3 Insert a CR2032 (or equivalent) lithium coin cell backup
battery. The side marked with a + (plus sign) faces up.

4 Replace the backup battery door and the screw.

The main batteries

You can use the Philips Velo Rechargeable NiMH Battery Pack
included with your Velo 500. Rechargeable AA NiCd batteries are
not recommended.

Note Battery life will vary depending on how you use your Velo 500.

To install the main batteries
1 Slide the battery door lock switch down to release the

battery door.

2 Swing the battery door open until it detaches completely.

3 Insert the Philips Velo Rechargeable Battery Pack into the
battery compartment.

A tab on the Philips Velo Rechargeable Battery Pack
indicates the date of manufacture. When you insert the
battery pack, position this tab so you can use it to pull
the battery from the compartment.

4 Replace the battery door, and slide the lock switch up to
lock the battery door.

Caution If you remove all main and backup batteries and
disconnect external power, you will lose all information in your Velo
500 and will need to restore your data from your desktop computer.
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Low battery indicators

Your Velo 500 displays warning messages when batteries are low.
Take immediate action if you see these messages.

Caution To avoid data loss, do not allow the backup battery to run
down. Replace it as soon as you see a message that your backup
battery is low. Also, do not remove the backup battery unless the
main batteries are installed and are in good condition (or you are
connected to external power).

Tips for conserTips for conserTips for conserTips for conserTips for conserving baving baving baving baving battertterttertterttery poy poy poy poy powwwwwererererer

◗ Do not use battery power when using PC Card accessories.
PC Cards require considerable power to operate and can
quickly drain your Velo 500’s batteries. Always use external
power when making dial-up connections with a PC Card
modem. (The internal modem has very low power
consumption compared to PC Card modems. It is not
necessary to use external power with the internal modem.)

◗ Shorten auto-suspend time. To conserve battery power,
your Velo 500 automatically suspends operation while on
battery power after three minutes if you have not touched
the keyboard or used the stylus. To maximize battery life,
you can shorten this time. For more information, see “The
Power control panel” in “Fine-tuning performance.”

◗ When your Velo 500 is connected to your desktop computer,
make sure the Velo Dock is connected to the AC adapter.
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◗ Set the backlight to turn off automatically when running on
battery power. Use the Display control panel to set Backlight
options. For more information, see “Adjusting display
properties” in “Fine-tuning performance.”

◗ Turn off sound events you do not require. Use the Volume
& Sounds control panel to set custom sound schemes. For
more information, see the Adjusting Volume and Sounds
help topic on your Velo 500.

The AC adapter

Use the AC adapter to power your Velo 500 and to recharge the
Philips Velo Rechargeable Battery Pack. You can connect the AC
adapter directly to your Velo 500 or use it to power the Velo Dock
while your Velo 500 is connected to your desktop computer. For
more information on using the Velo Dock, see “The Velo Dock” in
“Connecting to a desktop computer.”

The AC adapter included with your Velo 500 is for use with
110-V AC power only. If you travel frequently or need to
power your Velo 500 at other AC voltages, you can purchase
an optional Philips Traveling AC Adapter. For information about
the availability of AC adapters and other accessories, check the
Philips Web site (http://www.mobile.philips.com/).

Warning Use only Philips power adapters designed specifically for
use with the Velo 500; otherwise, you may damage your Velo 500.

To connect your Velo 500 to external power
1 Plug the power adapter into an AC power outlet.

2 Plug the AC adapter into the DC jack on your Velo 500.

If the Philips Velo Rechargeable Battery Pack is installed,
the batteries will be recharged while your Velo 500 is
connected to AC power.

Note When the Philips Velo Rechargeable Battery Pack is installed
for the first time, you should connect your Velo 500 to AC power and
fully charge the battery pack before you disconnect the AC adapter.
Charging should take about two-and-a-half hours. While the battery
pack is charging, the green recharging indicator light  is on. The light
turns off when charging is complete.
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Using yUsing yUsing yUsing yUsing your our our our our VVVVVelo 500 for the first timeelo 500 for the first timeelo 500 for the first timeelo 500 for the first timeelo 500 for the first time
To start your Velo 500 for the first time
1 Slide the latch to the right and open the lid.

2 Press the Power button.

The Power button is just above the keyboard near the left
side of the Velo 500 (see Figure 1).

3 The H/PC Setup Wizard will start automatically. Follow
the instructions on the screen to set up your Velo 500.

4 If necessary, adjust the display contrast by pressing ALT+>
or ALT+< on the Velo 500 keyboard.

The H/PC Setup Wizard

The first time you use your Velo 500, the H/PC Setup Wizard will
present a brief introduction to the Windows CE operating system
and lead you through a few simple setup procedures:

◗ Calibrate the touch screen. Calibration establishes the
alignment of the background image with the touch-sensitive
portion of the screen and ensures the accuracy of your
stylus taps.

◗ Set your time zone. Select your home city. Windows CE
stores area codes, airport information, sunrise/sunset times,
and relative distances for hundreds of cities all over the
world.

◗ Set the date and time. Because Windows CE uses the date
and time to remind you of appointments as well as to
synchronize files and PIM data with your desktop computer,
it’s important to set the date and time correctly.

◗ Enter optional owner information, such as name, address
and phone number. The information you type will be
displayed whenever you turn on your Velo 500 and may
help someone return your Velo 500 to you if it’s lost.

To begin Setup
1 Install the main and backup batteries according to the

instructions earlier in this chapter.

2 Turn on your Velo 500.

3 Follow the H/PC Setup Wizard instructions on your screen.
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Later, you can restart the H/PC Setup Wizard or use Control Panel
to change any of the options you set during setup.

To restart the H/PC Setup Wizard
◗ Browse to the Program Files\Accessories folder, and

double-click the Welcome icon.

WindoWindoWindoWindoWindows CE basicsws CE basicsws CE basicsws CE basicsws CE basics

Microsoft Windows CE 2.0 is similar to the Microsoft Windows 95
operating system. It includes familiar components such as the
Start button and Start menu, taskbar, desktop, browser, menu
bar, toolbar, Control Panel, and shortcuts.

Using the stylus

On your Velo 500, you use the stylus in much the same way that
you use a mouse with your desktop computer. Instead of clicking
with the mouse, tap the stylus on the screen to select objects or
activate menus. You should use the supplied stylus to touch the
screen. There’s no harm in using your fingertip, but many features
require the stylus for finer pointing.

Warning Don’t use sharp objects, such as keys or pens, to touch the
screen. These objects can damage the screen.

To use the stylus
◗ Slide the stylus to the right until it is out of the slot.

To replace the stylus
◗ Slide the stylus into the slot, point first and ridges

facing up.

Double-tap programs and documents to open them, just as you
would double-click with a mouse. You can set the double-tap rate
using the Stylus control panel.

To set the double-tap rate
1 On the Start menu, point to Settings, and tap Control

Panel.

2 Double-tap the Stylus icon.

3 Tap the Double-Tap tab.
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4 Double-tap the checkerboard to set the speed and area of
your double-tap.

5 Double-tap the clapper board to test your settings.

If you cannot select objects accurately with your stylus or if you
notice that the accuracy of the stylus has diminished over time,
you may need to record new calibration settings. You can use the
Stylus control panel to recalibrate the touch screen.

To recalibrate the touch screen
1 On the Start menu, point to Settings, and tap Control

Panel.

2 Double-tap the Stylus icon.

3 Tap the Recalibrate tab.

4 Press and briefly hold the stylus on the center of the
target each time it stops. It is important that the stylus
is the only thing touching the screen. Be careful not to
touch the screen with your fingers while calibrating.

5 Press the ENTER key to accept the settings, or press the
ESC key to cancel the settings and start over.

If you make a mistake when calibrating the touch screen or if,
over a period of time the accuracy of the touch screen diminishes,
you may not be able to navigate with the stylus. To open the
stylus calibration screen without using the stylus, simultaneously
press CTRL+ALT+=, or press ÿ+I.

The Windows CE taskbar

The Windows CE taskbar provides a quick way to switch between
programs and open documents. Each open document or running
program is shown as a button in the taskbar.

◗ To switch to a program or document, tap the taskbar button.

◗ To minimize the active program, tap the button for the active
program or document.

◗ To minimize all programs and display the desktop, tap the
desktop icon at the right edge of the taskbar.

You can set several options for the taskbar, such as whether
the taskbar remains visible in all programs (Always on top and
Auto hide) and whether the clock is displayed (Show Clock).
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To set taskbar options
1 On the Start menu, point to Settings, and tap Taskbar.

2 Select the options you want.

Tip To quickly display the taskbar when it is hidden, press the ÿ key.

The status area on the right side of the taskbar may display several
icons that indicate the status of your Velo 500, such as the state
of Caps Lock, whether a connection is active, and whether the
device is connected to external power. In most cases, you can
double-tap a status icon for more information or to change
options associated with that icon.

SoftwSoftwSoftwSoftwSoftwararararare pre pre pre pre prooooogramsgramsgramsgramsgrams

Your Velo 500 includes many useful programs that provide all the
functionality you need as a mobile professional. You can also add
programs from other vendors.

Preinstalled programs

The programs included on your Velo 500 are described below.
Start these programs by double-tapping the desktop shortcut or
tapping the icon in the appropriate folder on the Start menu.
Detailed procedures for common tasks are available in Help.
To access Help for a specific program, start the program, and
then tap Help on the Start menu, or tap  in the toolbar.

AccessoriesAccessoriesAccessoriesAccessoriesAccessories

Calculator—Perform calculations by tapping on-screen buttons
or using the Velo 500 keyboard. Keep track of calculations with an
on-screen “paper tape,” or copy data and paste it into documents
and spreadsheets.

World Clock—Keep track of the current date and time, whether
you’re at home or away. You can set the clock to keep time for
your home city and for a place you’re visiting, and choose which
of these time zones to use as your system time. World Clock also
stores information on time zones, airports, dialing codes, and
distances, and even calculates sunrise and sunset for many cities
in the world.
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CommunicaCommunicaCommunicaCommunicaCommunicationstionstionstionstions

ActiveSync—ActiveSync enables you to connect to one or more
remote computers and synchronize your calendar, tasks, contacts,
and mail messages between Pocket Outlook on your Velo 500 and
Microsoft Outlook or Schedule+ on the remote computer. You can
also synchronize files in the Synchronize Files folder on your Velo
500 with files in the My Documents or Personal folder on your
desktop computer.

PC Link—The PC Link program manages the connection between
your Velo 500 and desktop computer. Use PC Link to connect,
disconnect, or check the status of the current connection.

Remote Networking—Use Remote Networking to connect to an
Internet service provider or to a corporate network computer that
has been configured as a remote access server. After connecting to
a remote computer, you can browse the Web with Pocket Internet
Explorer and send and receive e-mail messages with Inbox.
Remote Networking can use either PPP (point-to-point protocol)
or SLIP (serial line Internet protocol) to communicate with a host
computer.

Terminal—Use Terminal to connect to online services that
require TTY or VT-100 terminal emulation. For example, you
can view and download files from a bulletin board or send and
receive e-mail using your Velo 500 Terminal application.

MicrMicrMicrMicrMicrosoft Posoft Posoft Posoft Posoft Pockockockockocket Officeet Officeet Officeet Officeet Office

Microsoft Pocket Excel—Calculate expenses, create reports,
or manage data using this application. In addition, you can track
an investment return or keep an up-to-date mileage log while
you’re on the road. Using Windows CE Services, you can transfer
spreadsheets from your desktop computer to your Velo 500 and
take them with you, or transfer spreadsheets from Pocket Excel
to Microsoft Excel on your desktop computer.

Microsoft Pocket PowerPoint—Pocket PowerPoint lets you use
your Velo 500 to view presentations created on your desktop
computer. You can display presentations on the Velo 500 screen
or connect to a VGA monitor using an optional V-Module and
VGA PC Card.
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Microsoft Pocket Word—Take notes, compose memos, and
review reports anytime, anywhere. You can create and edit files
in Pocket Word, and then transfer them to Microsoft Word for
printing, or transfer Microsoft Word files to Pocket Word to review
while you’re traveling.

MicrMicrMicrMicrMicrosoft Posoft Posoft Posoft Posoft Pockockockockocket Outlooket Outlooket Outlooket Outlooket Outlook

Track contacts, manage your schedule, organize tasks, and send
and receive e-mail with the integrated components of Pocket
Outlook. When you are traveling or attending meetings away from
your desk, use your Velo 500 to organize your day. If you also use
a Microsoft information manager, such as Outlook or Schedule+,
on your desktop computer, you can automatically update the
information in Pocket Outlook by synchronizing your Velo 500
with your desktop computer. Pocket Outlook includes four
components: Calendar, Contacts, Tasks, and Inbox. If you have
an account with an Internet service provider, you can use Inbox
to send and receive Internet e-mail messages via a dial-up
connection. If you have Microsoft Exchange or Microsoft Outlook
installed on your desktop computer, you can also transfer
messages between Inbox and your desktop computer.

VVVVVelo elo elo elo elo ApplicaApplicaApplicaApplicaApplicationstionstionstionstions

Alarm—With Alarm, you can use your Velo 500 as a desktop
alarm clock. The Alarm program displays the system time as a
full-screen digital clock. You can set an alarm to play a sound or
flash the LED, and change the display to show hours and minutes
or hours, minutes, and seconds.

bFAX™ Pro and bView™—These two full-featured programs
from bSquare™ Development enable you to fax documents
from your Velo 500 and to view faxes you receive from others.
Use bFAX Pro for sending and receiving faxes and bView for
previewing and adjusting the appearance of documents before
they are faxed. You can use bFAX Pro to send documents created
in other programs on your Velo 500, such as Pocket Word (.pwd)
files, H/PC bitmap (.2bp) files, received fax (.tif) files, and ASCII
text (.txt) files. You can customize bFAX Pro by setting options
for your cover page and page layout.
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Characters—Use the Characters program to enter international
characters or symbols and characters not available on the
keyboard. Select a font from the drop-down list to display
the complete character set for that font, then select and copy
characters directly into other programs, such as Pocket Word
documents or e-mail messages.

Database—AllPen® Mobile Forms Database helps you organize
information on your Velo 500 and share that information with
your desktop computer. AllPen Mobile Forms Database lets you
create, modify, and customize a database. After you have entered
information into a personal database, you can update, sort, search,
and manage your database with your Velo 500. You can view
stored records, one record at a time or in a List view that shows
all the records in the database. You can sort the information in
your database or list all records that contain some piece of text in
one of the fields. The information in the database is always saved
in the Database folder on your Velo 500.

FindIt—FindIt enables you to search for files on your Velo 500.
You can search for a file by file name or refine your search to
look only in a certain folder, to locate files based on size, date,
or type, and to search for files that contain a specific text string.

Reset—The Reset program (Reset.exe) provides a reliable method
for resetting your Velo 500 while preserving your data after you
restore data from your desktop computer or when the operating
system stops responding to your commands or stylus taps. There
are several methods for resetting, depending on the severity of the
problem, but you should try the Reset program first. For more
information, see “Resetting your Velo 500.”

Unit Conversion—Use the Unit Conversion program to convert
between English and metric units for distance, volume, weight,
and temperature or to convert currency between many
international monetary units. When converting currency, you
can use the approximate exchange rates provided or enter a
more current exchange rate.
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Voice Memo—Record and manage spoken memos and other
sounds, without even opening your Velo 500. The button on the
lid provides convenient one-touch recording anywhere. Voice
memos are stored as .wav files, and you can record up to 16
minutes of sound per 1 MB of storage memory. After you record
a voice memo, you can play it back, file it, or delete it when you
no longer need it. Use the Audio Levels control panel to set input
and output levels for the Voice Memo program.

MicrMicrMicrMicrMicrosoft Posoft Posoft Posoft Posoft Pockockockockocket Interet Interet Interet Interet Internet Explornet Explornet Explornet Explornet Explorererererer

View the wide range of information available on the World Wide
Web. Like Internet Explorer on your desktop computer, Pocket
Internet Explorer features a toolbar that makes it easy to enter
an address, return to your start page, and save your favorite
addresses. Before you can use Pocket Internet Explorer, you must
have an account with an Internet service provider and create a
dial-up connection to this account using Remote Networking.

Installing additional programs

Programs can be purchased from many third-party vendors, such
as MobileSoft (http://www.mobilesoft.com/). Check the Philips
and Microsoft Web sites for links to other companies developing
software for Windows CE. Programs must be written specifically
for Windows CE. You cannot use programs designed for Windows
95 or Windows NT on your Velo 500.

Typically, when you add new software to your Velo 500, you
install the program from your desktop computer. For more
information, refer to the software vendor’s instructions.

To add a program to your Velo 500
1 Copy the program to your desktop computer, or insert the

installation disk or CD-ROM in a drive on your desktop
computer.

2 Connect your Velo 500 to your desktop computer. See
page 25 for instructions.

3 On your desktop computer, double-click the installation
icon, or type a:setup, where a: is the letter of the drive
containing the installation program.

You can also copy fonts, sounds, and graphics from your desktop
computer to your Velo 500.
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To add fonts, sounds, or graphics to your Velo 500
1 Connect your Velo 500 to your desktop computer, and

start Windows CE Services.

2 On your desktop computer, drag the file(s) to the
Windows folder on your Velo 500.

Note Because fonts, sounds, and graphics can use up valuable storage
memory, you should add only the files you need and delete those that
you don’t use.

Removing programs

You can free up storage memory on your Velo 500 by removing
programs you don’t use or don’t need. Programs you’ve installed
can be removed by using the Remove Programs control panel;
however, you cannot remove the pre-installed programs that came
with your Velo 500 and are stored
in ROM.

To remove software from your Velo 500
1 On the Start menu, point to Settings, and tap Control

Panel.

2 Double-tap the Remove Programs icon.

3 Select the program you want to remove from the list.

4 Tap Remove.

Quick Start keys

Velo 500 Quick Start keys enable you to start your favorite
programs at the touch of a button. By default, the Quick Start
keys are assigned to the most common Velo 500 programs, but
you can reassign the keys to start any program or open any file
using the Quick Start control panel.

To start a program with a Quick Start key
◗ On the keyboard, hold down the ALT key, and press one

of the number keys.

Default program assignments are printed on the keyboard
above the numbered keys.
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To assign a program or document to a Quick Start key
1 On the Start menu, tap Settings, and then tap Control

Panel.

2 Double-tap the Quick Start icon.

3 Under Key Combination, select the Quick Start key you
want to change.

4 Under File to Launch, type the full path of the program
or file you want to start, or click Browse to locate the
file.

5 If you want to include parameters when the program
starts, type these under Launch Parameters. If you’re
not sure or you don’t want to specify parameters, leave
this space blank.

6 Click OK to save your settings and exit the control panel.

Fine-tuning performanceFine-tuning performanceFine-tuning performanceFine-tuning performanceFine-tuning performance

This section explains how to change or set several properties of
the Velo 500 to suit your personal preferences and working style
and provides tips on how to get the most from your Velo 500.

The Power control panel

Use the Power control panel to check the status of the batteries
in your Velo 500 and to set options for Auto Suspend. By default,
your Velo 500 automatically suspends operation while on battery
power after three minutes if you have not touched the keyboard
or used the stylus. To maximize battery life, you can shorten this
time.

To check battery power
1 On the Start menu, point to Settings, and tap Control

Panel.

2 Double-tap the Power icon.

3 Tap the Battery tab to view battery status.

Tip The battery icon will appear only when the batteries
begin to weaken. You can then view the battery status by
double-tapping the Power icon in the status area of the
taskbar.
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To adjust the auto-suspend time
1 On the Start menu, point to Settings, and tap Control

Panel.

2 Double-tap the Power icon.

3 On the Power Off tab, select a time delay from the list.

Note Your Velo 500 will not suspend while it is connected
to a desktop computer.

Adjusting display properties

You can change several properties of the Velo 500 screen to
improve visibility in different lighting conditions. This section
explains how to adjust the contrast, set the screen to display either
4 or 16 shades of gray, and use the backlight so you can work
when there is not enough ambient light available.

To adjust the contrast
◗ On the keyboard, simultaneously press ALT+< or ALT+>

until the display is at the desired contrast.

Change the Gray Scale settings to improve performance or display
images with higher quality. Graphics and Web pages will look
better at 16 shades of gray; however, overall performance is faster
when the display is set to 4 shades of gray.

To change the screen resolution
1 On the Start menu, point to Settings and tap Control

Panel.

2 Double-tap the Gray Scale icon.

3 Select either 4 or 16 grays.

You can press ALT+SPACE to turn the backlight on and off or you
can set the backlight to turn on automatically when you touch the
screen or type on the keyboard.

Because the backlight consumes a significant amount of power,
you can set the backlight to turn off automatically when you have
not touched the screen or typed on the keyboard for awhile.
Setting the backlight to turn off automatically helps extend the life
of the batteries.
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To turn the backlight on or off
◗ Simultaneously press ALT+SPACE.

To set automatic backlight options
1 On the Start menu, point to Settings, and tap Control

Panel.

2 Double-tap the Display icon.

3 Tap the Backlight tab.

4 Select the options you want.

Memory management

The memory on your Velo 500 is allocated between storage
memory and program memory. If you do not have enough space
for a file, you should increase the amount of storage memory.
If your Velo 500 is running slowly, try increasing the amount of
program memory.

To adjust memory allocation
1 Delete any unnecessary files and empty the Recycle Bin

(see the following procedure).

2 Exit all programs.

3 On the Start menu, point to Settings, and tap Control
Panel.

4 Double-tap the System icon.

5 On the Memory tab, adjust the memory slider, as
appropriate.

Note In some cases, resetting your Velo 500 can free
up additional storage and/or program memory. If you
experience memory problems, quit all programs, and run
the Reset program. For more information, see “Resetting
your Velo 500” in this manual.

You can increase the amount of memory available by deleting files
you no longer need. Files you delete are stored in the Recycle
Bin; they are not actually removed from your Velo 500 until you
“empty” the Recycle Bin. To free up memory, you should
periodically empty the Recycle Bin.
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 To delete a file or folder
1 In Windows CE Explorer or My Handheld PC, select the

file or folder you want to delete.

2 In the toolbar, tap the delete icon [icon].     ???

To empty the Recycle Bin
1 Double-tap the Recycle Bin icon.

2 On the File menu, tap Empty Recycle Bin.

You can customize the Recycle Bin to remove deleted files
immediately or to allocate more or less space for deleted files.

To adjust the Recycle Bin settings
1 Double-tap the Recycle Bin icon. Make sure no files are

selected.

2 On the File menu, tap Properties.

3 To remove deleted files immediately, select the Do not
move files to the Recycle Bin check box.

4 To adjust the amount of storage memory allocated to
deleted files, move the slider.

Connecting to a desktop computerConnecting to a desktop computerConnecting to a desktop computerConnecting to a desktop computerConnecting to a desktop computer

The Microsoft compact disk that came with your Velo 500 includes
Windows CE Services 2.0 with ActiveSync™, a program that
enables you to transfer files between your desktop computer and
Velo 500, to synchronize data from the Pocket Outlook programs
on your Velo 500 with Outlook or Schedule+ on your desktop
computer, transfer e-mail messages from Inbox on your Velo 500
to either Outlook or Microsoft Exchange, and synchronize
documents, spreadsheets, or data files. This section tells how to
install Windows CE Services 2.0 with ActiveSync and gives you
an overview of the functions. For detailed procedures, refer to
Windows CE Services Help on your desktop computer.

In addition to Windows CE Services 2.0, the Windows CE Services
compact disc contains Microsoft Schedule+ 7.0a and updates
to the Windows Messaging System (Microsoft Exchange) and
Windows 95 Dial-Up Networking. The installation program will
check for and install these components, as necessary, to ensure
that you can set up and run Windows CE Services 2.0.
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System requirements

The minimum PC requirements for running Windows CE
Services 2.0 are as follows:

◗ Microsoft Windows NT Workstation 4.0 or Windows 95

◗ Desktop computer with a 486/33DX or higher processor
(Pentium® P90 recommended)

◗ 12 MB of memory for Windows NT Workstation 4.0

◗ 8 MB of memory (12 MB recommended) for Windows 95

◗ Hard disk drive with 10 to 50 MB of available hard disk
space (actual requirements will vary, based on selection of
features and current system configuration)

◗ Available 9- or 25-pin communications port (for a 25-pin
port, use the adapter included with your Velo 500.)

◗ CD-ROM drive

◗ VGA or higher-resolution graphics card (Super VGA
256-color recommended)

◗ Keyboard

◗ Microsoft Mouse or compatible pointing device

In addition, the following optional system components will
allow you to use certain features of Windows CE Services:

◗ Audio card and speakers for sound

◗ Microsoft Office 97 or Microsoft Office 95

◗ Serial or built-in infrared adapter for synchronization

◗ Modem for remote synchronization

◗ Ethernet LAN connection for remote synchronization
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Installing Windows CE Services 2.0

The Windows CE Services 2.0 installation program includes
several steps. The steps you follow depend on your operating
system (Windows 95 or NT) and system configuration. When you
run Setup, it tests for installed components and prompts you to
install only those components you need. To ensure you install all
the necessary components, simply click each button in order on
the Setup screen. You may need to restart your computer after
each step.

To install Windows CE Services 2.0
1 Insert the Microsoft Windows CE Services compact disc

in a CD-ROM drive on your desktop computer.

Setup should begin automatically.

2 If Setup does not begin automatically, click Run on the
Start menu, and then type d:setup and press ENTER, where
d: is the letter of the drive containing the Microsoft
Windows CE Services compact disc.

3 Follow the instructions on your screen to complete
installation.

You can install optional items from the Windows CE Services
compact disc as the final step of the installation process. Optional
items on the Windows CE Services compact disc may include
networking components and infrared device drivers for your
desktop computer and/or Microsoft programs for your Velo 500.
If you choose to install the H/PC programs during Setup, you will
be prompted to connect your Velo 500 to your desktop computer
before completing the Setup program. For more information about
connecting your Velo 500 and establishing a partnership under
Windows CE Services 2.0, see “Establishing a partnership.”
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The Velo Dock

Use the Velo Dock to connect to your desktop computer and
to recharge your batteries (if the rechargeable battery pack is
installed).

FigurFigurFigurFigurFigure 5:e 5:e 5:e 5:e 5:     The The The The The VVVVVelo Dockelo Dockelo Dockelo Dockelo Dock

To connect to the Velo Dock
1 Plug the AC adapter into the DC jack on your

Velo Dock.

2 Connect the cable on the Velo Dock to a serial port on
your desktop computer.

3 Place your Velo 500 in the Velo Dock, and slide the
Velo 500 to the left until it snaps into place.

Note If you are having trouble connecting to your desktop computer,
be sure your Velo is securely docked.

4 Never exert pressure on the cover to insert into, or
remove your Velo from, the Dock. Always grip the bottom
of the device.

Note You can also connect your Velo 500 to your desktop computer
using the optional serial cable. For information about the availability
of serial cables and other accessories, check the Philips Web site at
http://www.mobile.philips.com/
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Establishing a partnership

Windows CE Services 2.0 creates a partnership between your Velo
500 and your desktop computer. This allows you to synchronize
documents, appointments, tasks, and contacts, as well as to back
up your data and transfer files. To establish this partnership, you
need to set up Windows CE Services 2.0 by connecting your
Velo 500 to your desktop computer and completing the New
Partnership Wizard. The wizard helps set up components for the
various tasks that Windows CE Services 2.0 performs, including
backing up your Velo 500 data and synchronizing data. You can
learn more about backing up, synchronizing, and transferring files
later in this section.

To connect your Velo 500 to your desktop
computer and establish a partnership
1 Insert the serial port connector of the Velo Dock into the

serial port of your desktop computer which you selected
during Windows CE Services 2.0 setup.

2 Place your Velo 500 in the Velo Dock.

Your Velo 500 will turn on automatically, and the red
serial connection indicator light  will blink. After a few
moments, Windows CE Services 2.0 should recognize the
connection.

Note If you have enabled password protection on your
Velo 500, Windows CE Services 2.0 requests that you enter
a password before it will recognize the connection.

3 If you are running Windows NT on your desktop
computer, the logon screen appears on your Velo 500.
Type guest in the User Name box, make sure that both
the Password and Domain boxes are empty, and
then tap OK. If you or your network administrator have
changed permissions for the guest account, you may have
to log on using your personal NT account (including your
domain and password).

4 Windows CE Services 2.0 starts the New Partnership
Wizard. Follow the instructions on your screen.
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BrBrBrBrBrooooowsing ywsing ywsing ywsing ywsing your our our our our VVVVVelo 500 desktopelo 500 desktopelo 500 desktopelo 500 desktopelo 500 desktop

When your Velo 500 is connected to your desktop computer, you
can use Windows CE Services 2.0 to browse files on your Velo
500, just as you would browse files in any other folder. The only
difference is that you cannot start programs that reside on the
Velo 500 from Windows CE Services; double-clicking the icon for
a program or file residing on your Velo 500 displays the properties
for that program or file.

When you install Windows CE Services 2.0, the Mobile Devices
folder is created in the root folder of your hard disk. When
connected to your desktop computer, your Velo 500 appears as
an icon in the Mobile Devices folder.

To start Windows CE Services
1 Connect your Velo 500 to your desktop computer.

Note The first time you connect your Velo 500,
Windows CE Services 2.0 may prompt you to select a
communications port. Select the port to which your Velo
Dock or serial cable is connected, and make sure the port
speed is set to 19,200.

2 In My Computer, browse to the Mobile Devices folder,
and double-click the Velo 500 icon.

Synchronizing data and filesSynchronizing data and filesSynchronizing data and filesSynchronizing data and filesSynchronizing data and files

Windows CE Services 2.0 with ActiveSync enables you to
synchronize data between Microsoft Outlook or Schedule+ on
your desktop computer and the Pocket Outlook programs on
your Velo 500. You can also synchronize the files in the My
Documents\Synchronize Files folder on your Velo 500 with files
in the My Documents (Windows 95) or Personal (Windows NT)
folder on your desktop computer. Files and Outlook data can be
synchronized automatically or manually.

If you choose to synchronize data automatically, ActiveSync will
update all data whenever you connect your Velo 500 to your
desktop computer. By synchronizing data automatically, you can
be sure your appointments, tasks, and contacts are always readily
accessible. If you choose to synchronize manually, you can do so
at any time by clicking Synchronize Now on the Tools menu in
the Mobile Devices window.
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A synchronization conflict occurs when the same item has been
modified both on the desktop computer and on the Velo 500. If
you have conflicting items after synchronization, you will be
prompted to resolve them in the Resolve Conflict dialog box.
You can also set ActiveSync to resolve conflicts automatically the
next time you synchronize.

Note You cannot synchronize data by dragging an Outlook or
Schedule+ data file to your Velo 500.

Backing up and rBacking up and rBacking up and rBacking up and rBacking up and restoring yestoring yestoring yestoring yestoring your our our our our VVVVVelo 500 daelo 500 daelo 500 daelo 500 daelo 500 datatatatata

You can use Windows CE Services to back up your Velo 500 data
to a storage file on your desktop computer. If the information is
ever lost or corrupted on your Velo 500, you can restore the data
from the backup file.

You can back up your Velo 500 manually by updating the backup
file when you’ve made important changes, or you can set
Windows CE Services to automatically back up any changes each
time you connect your Velo 500 to your desktop computer.
For more information on backing up your Velo 500 and setting
backup options, refer to Windows CE Services Help on your
desktop computer.

The first time you back up your Velo 500, you are asked to
specify a location for the backup file. Do not store the backup
file in your desktop computer’s temporary folder (by default,
Windows\Temp). Backup will not operate correctly, and the
integrity of your data will be compromised if you use your
temporary directory.

When you restore your Velo 500 from the backup file, all
information on your Velo 500 is erased and replaced by the
information in the backup file. Any changes you’ve made since
the last backup will be lost. After restoring data, you must
disconnect and reset your Velo 500 using the Reset program
(see “Resetting your Velo 500”). If you fail to reset, your Velo 500
will not function properly, and you will be unable to reconnect
until the reset is completed.
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You can transfer files between your desktop computer and your
Velo 500 by dragging files to and from the Velo 500 icon in the
Mobile Devices folder or by using Cut, Copy, and Paste on the
Edit menu.

When you drag or copy and paste a file between your Velo 500
and your desktop computer, a version of the file exists in both
locations. If you convert or transfer a file, make changes to the
file, and then convert or transfer the file back to its original
location, Windows CE Services assigns the file a new file name
to preserve the integrity of your original file.

In addition to transferring files, you may need to convert certain
file types, such as Microsoft Word or Microsoft Excel files, before
you can use them on your Velo 500. Files originating on the
Velo 500 that you want to transfer to or print from your desktop
computer may also have to be converted. You can set Windows
CE Services to convert selected file types automatically while they
are transferred, using conversions you specify or the defaults
provided for the most common types of files.

Caution When a file is transferred, it may be converted into a
different file type, and some formatting may be changed or removed
for efficiency. For more information about file conversions, see
Windows CE Services Help on your desktop computer.

When creating files on the desktop computer, it is best to accept
the default file name extension. If you change the extension so
that it does not match the file type, file conversion may not work.

Printing files frPrinting files frPrinting files frPrinting files frPrinting files from yom yom yom yom your our our our our VVVVVelo 500elo 500elo 500elo 500elo 500

Your Velo 500 provides several options for printing. You can
connect your Velo 500 directly to a serial or parallel printer,
use the infrared port to send files to an IrDA-compatible printer,
or use Windows CE Services to print a file that resides on your
Velo 500 from a desktop computer.

To connect directly to a serial printer, you will need an optional
serial cable. For information about optional cables and other
accessories, check the Philips Web site at
http://www.mobile.philips.com/
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To print from your Velo 500
1 Line up the infrared port on your Velo 500 with the

infrared port on the printer.

2 On your Velo 500, open the document you want to print,
and tap Print on the File menu.

3 In the Print dialog box, select the port (infrared or serial)
and other printing options.

4 Tap OK.

If you print through Windows CE Services, the file is converted
and then printed using the print defaults established in the
desktop computer application to which the file is converted. If
the desktop application does not support printing, Windows CE
Services will not be able to print the file.

To print a file using Windows CE Services
1 Connect your Velo 500 to the desktop computer.

2 In My Computer on your desktop computer, double-click
the Velo 500 icon in the Mobile Devices folder, and select
the file you want to print.

3 On the File menu, click Print.

Connecting to a rConnecting to a rConnecting to a rConnecting to a rConnecting to a remote computeremote computeremote computeremote computeremote computer

The Velo 500 includes a built-in modem for connecting to a
telephone line and an infrared port for connecting to other
IrDA-compatible devices. You can use the modem to explore
the Internet, send and receive e-mail, send and receive faxes,
and connect to other services. Use the infrared port to share
files with another H/PC or to send files to an infrared-equipped
printer or PC.

This section provides an overview of the steps involved in
connecting to remote computers in these ways. For detailed
procedures, refer to “Getting Connected” in Windows CE Services
Help on your desktop computer and the Communications help
topic on your Velo 500.
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Modem connection

You can use the built-in modem or a PC Card modem to connect
your Velo 500 to a remote computer over the Internet or by dial-up
connection to a remote access service (RAS) server. In each case,
you must first use the Remote Networking program on your Velo
500 to configure a connection for the host computer. For detailed
instructions on configuring a connection, refer to “Getting
Connected” in Windows CE Services Help on your desktop
computer and the Communications help topic on your Velo 500.

Note To use the built-in modem on your Velo 500, you must select
Internal modem on COM 4 when creating a new dial-up connection.
For more information, refer to the Communications help topic on
your Velo 500.

Warning Do not connect your Velo 500 to a digital telephone line.
The internal modem is designed for use only with analog telephone
lines; connecting to a digital telephone line may damage the device.
Before connecting, verify that the line is analog or check with the
professional who maintains your telephone lines.

To connect to a telephone line
◗ Open the RJ-11 jack, and plug in a standard telephone

line.

The RJ-11 jack is on the lid of the Velo 500 (see Figure 2).

Note The built-in modem is designed for use only in the U.S.

Transferring files between H/PCs by infrared

If you need to give someone your meeting notes or turn in an
expense report, you can send these files from your Velo 500 to
another H/PC using the built-in infrared ports. You can send one
file at a time, which will be placed on the receiving H/PC. You
can also send contact cards from Pocket Outlook.
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Note If your desktop computer is equipped with an IrDA-compat-
ible infrared device, you can also use infrared to transfer files to and
from your desktop computer.  To do so, you must install infrared
device drivers for Microsoft Windows. For more information, refer to
the documentation that came with your infrared device.

To send or receive a file using infrared
1 In Windows CE Explorer on your Velo 500, select the file

you want to send, and then tap Send on the File menu.

2 Line up the infrared ports on the H/PCs.

Make sure that the receiving H/PC is turned on and is
within a few feet of the sending H/PC.

3 In Windows CE Explorer on the receiving H/PC, tap
Receive on the File menu.

To send or receive a contact card by infrared
1 In Contacts, select the contact card you want to send,

and then tap Send on the File menu.

You can send more than one contact card at a time by
selecting multiple cards in the contact list before you
tap Send.

2 Line up the infrared ports on the H/PCs.

Make sure that the receiving H/PC is turned on and is
within a few feet of the sending H/PC.

3 On the receiving H/PC, open Contacts, and then tap
Receive on the File menu.

Tips for infrarTips for infrarTips for infrarTips for infrarTips for infrared communicaed communicaed communicaed communicaed communicationtiontiontiontion

If you have trouble sending or receiving files by infrared, try the
following tips to improve communication:

◗ Position each H/PC so that the infrared ports line up with
one another. Make sure the infrared ports are within three
feet (one meter) of each other.

◗ Make sure neither infrared port is blocked. The infrared port
may be blocked if you swing the display fully open.

◗ Some types of fluorescent lamps may interfere with infrared
communication. To minimize interference, try turning off
some lights or moving to a location with different lighting.
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Occasionally, you will need to reset your Velo 500, for example,
after you restore data from your desktop computer or when the
operating system stops responding to your commands or stylus
taps. There are several methods for resetting, depending on the
severity of the problem. In most cases, you can reset your Velo
500 without losing any data; however, to ensure the safety of your
information, you should regularly back up your data to your
desktop computer.

The Reset program (Reset.exe) is the most reliable method for
resetting your Velo 500 while preserving your data. The Reset
program is already installed in the Velo Applications folder on
your Velo 500.

To reset your Velo 500 using the Reset program
1 On the Start menu, tap Programs, tap Velo

Applications, and then tap Reset.

2 In the Reset Velo 500 dialog box, tap Yes.

Only when the Reset program fails to correct a problem should
you press the Reset button with the stylus. Pressing the Reset
button once should retain the data stored on your Velo 500.

Caution Pressing the reset button multiple times will cause your
Velo 500 to do a full restart. This will erase all information not stored
in ROM.

In the most severe cases, such as when your Velo 500 doesn’t
respond to the Reset button or if you forget your password, you
may need to perform a “full restart” by removing all power,
including the main and backup batteries, from your Velo 500.
Resetting in this way will erase all files and programs you have
saved on your Velo 500.

Caution Performing a full restart by removing and reinstalling all
batteries erases all files, programs, and appointments you have
entered. You can restore this data from the backup file on your
desktop computer; however, the information will be only as current
as the most recent backup.
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Your Velo 500 comes with many built-in features, and you can
expand it to add even more capabilities. The Velo 500 includes
two slots for industry-standard Miniature Cards that can hold
additional memory and software. One slot can hold DRAM
Miniature Cards for memory expansion. The other slot can hold
either flash memory Miniature Cards for memory expansion
or ROM Miniature Cards for operating system upgrades (see
Figure 3). With the optional Type II PC Card V-Module, you can
add cellular modems, pagers, and other devices on PC Cards
(also called PCMCIA cards). Check the Velo 500 Web site
(http://www.mobile.philips.com/) for announcements of other
types of V-Modules that add more functionality to your Velo 500.

FigurFigurFigurFigurFigure 6:e 6:e 6:e 6:e 6:     TTTTType II PC Carype II PC Carype II PC Carype II PC Carype II PC Card d d d d VVVVV-Module-Module-Module-Module-Module

DRAM Miniature Cards

You can add memory by installing a DRAM Miniature Card in the
RAM slot on the bottom of your Velo 500. Memory contained on
a DRAM Miniature Card can be used as either storage or program
memory, and is included in the system memory shown on the
Memory tab of the System control panel.

Warning Only Philips Miniature Cards are guaranteed to work
properly with the Velo 500.
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To install a DRAM Miniature Card
1 Back up your Velo 500 using Windows CE Services on

your desktop computer. (For instructions on backing up
your Velo 500, see Windows CE Help on your desktop
computer.)

2 Turn off your Velo 500.

Caution If you remove all main and backup batteries and
disconnect external power, you will lose all information
you have entered. You can restore this data from the backup
file on your desktop computer; however, the information
will be only as current as the most recent backup. Make
sure you back up your Velo 500 immediately before
removing all batteries.

3 Remove all batteries (including the backup battery).

4 Remove the screw from the DRAM Miniature Card slot,
and remove the door to the slot and the dummy card.

Note Save the dummy card so you can reinsert it if you
remove the DRAM Miniature Card.

5 Insert the connector side of the DRAM Miniature Card
into the connector slot on the Velo 500, and push down
on the DRAM Miniature Card until it snaps into position.

6 Replace the door.

7 Replace the screw, and install the batteries.

8 Turn on your Velo 500.

9 Restore the data to your Velo 500 using Windows CE
Services 2.0 on your desktop computer.

10 If your Velo 500 does not reset automatically when you
turn it on, run the reset program to ensure proper
synchronization. (On the Start menu, point to Programs,
point to Velo Applications, and tap Reset.)
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To remove a DRAM Miniature Card

Caution Make sure your data will fit into your Velo 500 after
removing the DRAM Miniature Card.

1 Back up your Velo 500 using Windows CE Services on
your desktop computer. (For instructions on backing up
your Velo 500, see Windows CE Help on your desktop
computer.)

2 Quit all programs, and turn off your Velo 500.

Caution If you remove all main and backup batteries and
disconnect external power, you will lose all information
you have entered. You can restore this data from the backup
file on your desktop computer; however, the information
will be only as current as the most recent backup. Make
sure you back up your Velo 500 immediately before
removing all batteries.

3 Remove all batteries (including the backup battery).

4 Remove the screw from the DRAM Miniature Card slot,
and remove the door to the slot.

5 Push the tip of the stylus between the DRAM Miniature
Card and the white latch (See Figure 7). The DRAM
Miniature Card will pop up.

FigurFigurFigurFigurFigure 7:e 7:e 7:e 7:e 7: Remo Remo Remo Remo Removing the DRAM Miniaving the DRAM Miniaving the DRAM Miniaving the DRAM Miniaving the DRAM Miniaturturturturture Care Care Care Care Card with the stylusd with the stylusd with the stylusd with the stylusd with the stylus
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6 Remove the DRAM Miniature Card.

7 Replace the dummy card and the cover.

8 Replace the screw, and install all batteries.

9 Turn on your Velo 500.

10 Restore the data to your Velo 500 using Windows CE
Services 2.0 on your desktop computer.

Caution Any data stored on your DRAM Miniature Card
will be lost.

Flash memory Miniature Cards

You can add storage memory by installing a flash memory
Miniature Card in the Flash/ROM slot on the bottom of your
Velo 500. Storage memory on a flash memory Miniature Card
will not be included on the Memory tab of the System control
panel. You will not lose the information that is stored on the
card when you remove the flash memory Miniature Card.

Note You cannot add a flash memory Miniature Card if you already
installed an operating system upgrade ROM Miniature Card in the
Flash/ROM slot.

Caution After you install or remove a flash memory Miniature Card,
your Velo 500 will reset automatically. Any unsaved information will
be lost.

To install a flash memory Miniature Card
1 Connect your Velo 500 to your desktop computer.

2 Insert the Flash Memory Miniature Card disk into a disk
drive on your desktop computer.

3 On the Start menu, click Run, and then type a:setup and
press ENTER, where a: is the letter of the drive containing
the Flash Memory Miniature Card disk.

4 Follow the instructions on your screen.

Note Check the Philips Web site (http://www.mobile
.philips.com/) for the latest version of the Flash Memory
Miniature Card software.
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5 Quit all programs, and turn off your Velo 500.

6 Slide back the switch to open the door to the Flash/ROM
slot, and remove the door and the dummy card.

Note Save the dummy card so you can reinsert it if you
remove the flash memory Miniature Card.

7 Insert the flash memory Miniature Card and replace
the door.

8 Turn on your Velo 500.

FigurFigurFigurFigurFigure 8:e 8:e 8:e 8:e 8: Inser Inser Inser Inser Inserting a flash memorting a flash memorting a flash memorting a flash memorting a flash memory Miniay Miniay Miniay Miniay Miniaturturturturture Care Care Care Care Carddddd

You can open files and folders in the PC Card folder as you would
in any other folder on your Velo 500.

To remove a flash memory Miniature Card
1 Quit all programs and turn off your Velo 500.

2 Slide back the switch to open the door to the Flash/ROM
slot, and remove the door.

3 Remove the flash memory Miniature Card.

4 Replace the dummy card and the door.

5 Turn on your Velo 500.
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To remove the flash memory Miniature Card software
1 Remove the flash memory Miniature Card (see previous

section).

2 On the Start menu, point to Settings, and tap Control
Panel.

3 Double-tap the Remove Programs icon.

4 Select MCFlash from the list, and tap Remove.

5 In the Remove Program dialog box, tap Yes.

6 After MCFlash is removed from the list, tap OK.

Note You cannot remove the flash memory Miniature
Card software while the flash memory Miniature Card is
in your Velo 500.

Using PC Card accessories

By using the optional Type II PC Card V-Module, you can add
cellular modems, pagers, and other PC Card–based accessories to
your Velo 500.

Warning Not following the instructions for installing and removing
the V-Module can seriously damage your Velo 500.

To attach the V-Module
1 Be sure the V-Module latch on the bottom of the

V-Module is in the unlock position.

2 Be sure your Velo 500 is turned off.

3 Open the connector door on the bottom of your Velo 500.
(See Figure 3.)

4 Snap the V-Module to the bottom of the Velo 500,
aligning the connector (see Figure 9).

5 Slide the V-Module latch into the lock position.

Once the V-Module is attached, you can insert or remove PC
Cards without turning off the Velo 500.
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Warning Attach and detach the V-Module only when necessary.
Frequently attaching and detaching (multiple times per day) the
V-Module can ultimately damage your Velo 500.

To remove the V-Module
1 Be sure your Velo 500 is turned off.

2 Slide the latch on the bottom of the V-Module into the
unlock position.

3 Push back the V-Module release button, and remove the
V-Module.

4 Close the connector door on your Velo 500.

To install a PC Card in the V-Module
◗ Slide the PC Card into the V-Module’s card slot until it

locks in place.

You can use Type I or Type II PC Cards with the V-Module. For a
list of supported cards, see the Philips Velo 500 Web site at
http://www.mobile.philips.com/

To remove a PC Card from the V-Module
1 Push the PC Card release button located next to the PC

Card slot.

2 Remove the PC Card from the V-Module card slot.
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Physical description of the Velo 500

Dimensions 171 mm (6.75") by 95 mm
(3.75") by 32 mm (1.25")

Weight 370 g (13 oz.) without batteries

Power

Main battery Requires 1 NiMH rechargeable
battery pack

Backup battery Requires CR2032 lithium coin cell

DC jack 12V @ 500mA

Processor and basic input/output

Keyboard 61-key QWERTY layout
Quick Start keys to start applications

Display Backlit, nonglare, touch screen display,
grayscale LCD (640 x 240 pixels,
.23mm dot pitch) with controllable
contrast and on-demand backlighting

CPU 3.3V 32-bit MIPS-based PR31700
RISC processor @ 75 MHz

Memory 16 MB EDO DRAM,
16 MB Fast Page Mode ROM

Other input/output

Serial port RS-232 serial port
Supports data transfer rate up
to 230 kbps.

Infrared transceiver Meets IrDA standard (Level 1)
Data transfer rate up to 115 kbps.
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Indicator lights Green recharging indicator light 
indicates charging of the
rechargeable batteries

Red serial connection indicator
light  indicates communication
over the Serial connector

Yellow alarm indicator light 
indicates alarms or messages

Audio in Omnidirectional microphone used
in conjunction with Voice Memo
application

Records up to 16 minutes per MB using
TrueSpeech™ 8.5 sound compression

Audio out Speaker on the bottom can play
standard .wav files with sample rates:

8 kHz 8 or 16 bit mono
11 kHz 8 or 16 bit mono
11.025 kHz 8 or 16 bit mono
22 kHz 8 or 16 bit mono
22.050 kHz 8 or 16 bit mono

Modem 28.8-kbps data
9600-bps fax send/receive

Expansion

Velo Dock Provides connection to desktop
computer and external power supply.
Begins synchronization if software
is running on desktop computer.
Recharges batteries with Philips
rechargeable battery pack installed.

Miniature Card slots Two industry-standard expansion
slots for DRAM, Flash memory, or
ROM upgrades

Type II PC Card Contains one PC Card slot (Type II
V-Module (optional) PCMCIA), power specification:

Vcc= 5V @ 325mA, Vpp= 5V
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Declaration of conformity

This device complies with Part 15 of the FCC rules. Operation is
subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause
undesired operation.

Responsible Party Name Philips Mobile Computing Group

Telephone 1-888-275-8356

Product/Model Velo 500

FCC warning statement

This equipment has been tested and found to comply with the
limits for a Class B digital device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This
equipment generates, uses, and can radiate radio frequency energy.
If not installed and used in accordance with the instructions, it can
cause harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a
particular installation. Determine if the equipment does cause
interference to radio or television reception by turning the
equipment off and on. The user is encouraged to try to correct
the interference by one or more of the following measures:

1 Where it can be done safely, reorient or relocate the
receiving antenna.

2 Increase the separation between the equipment and
receiver.

3 Connect the equipment into an outlet on a circuit
different from that to which the receiver is connected.

4 Consult the dealer or an experienced radio/TV technician
for help.

Changes or modifications not expressly approved by the
manufacturer could void the user’s authority to operate the
equipment. Shielded interface cables must be used when
operating this device or the user’s authority to operate this
equipment could be voided.
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Telephone Consumer Protection Act of 1991

The Telephone Consumer Protection Act of 1991 makes it
unlawful for any person to use a computer or other electronic
device to send any message via a telephone facsimile machine
unless such message clearly contains, in a margin at the top or
bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of
the business, other entity, or individual sending the message and
the telephone number of the sending machine or such business,
other entity, or individual. To program this information into your
facsimile, complete the steps described in “To set up a fax service”
in Inbox Help on your Velo 500.

FCC Part 68 requirements
◗ This equipment complies with Part 68 of the FCC rules.

On the back of the computer is a label that contains,
among other information, the FCC registration number
and ringer equivalence number (REN) for this equipment.
If requested, this information must be provided to the
telephone company.

◗ The telephone company may make changes in its facilities,
equipment, operations, or procedures that could affect the
operation of the equipment. If this happens, the telephone
company will provide advance notice in order for you to
make the necessary modifications in order to maintain
uninterrupted service.

◗ If trouble is experienced with this equipment, please
contact Philips Mobile Computing Group at 1-888-275-8356
for repair and (or) warranty information. If the trouble is
causing harm to the telephone network, the telephone
company may request you remove the equipment from
the network until the problem is resolved.

◗ This equipment cannot be used on telephone company-
provided coin service. Connection to Party Line Service is
subject to state tariffs.

◗ This equipment is designed to be connected to the
telephone network or premises wiring using a compatible
modular jack which is FCC Part 68 compliant.
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Canadian IC CS-03 requirements

Notice: The Industry Canada label identifies certified equipment.
This certification means that the equipment meets certain telecom-
munications network protective, operational and safety require-
ments as prescribed in the appropriate Terminal Equipment
Technical Requirements document(s).
The Department does not guarantee the equipment will operate to
the user’s satisfaction.

Before installing this equipment, users should ensure that it is
permissible to be connected to the facilities of the local telecom-
munications company The equipment must also be installed using
an acceptable method of connection. The customer should be
aware that compliance with the above conditions may not prevent
degradation of service in some situations.

Repairs to certified equipment should be coordinated by a repre-
sentative designated by the supplier. Any repairs or alterations
made by the user to this equipment, or equipment malfunctions,
may give the telecommunications company cause
to request the user to disconnect the equipment.

Users should ensure for their own protection that the electrical
ground connections of the power utility, telephone lines and
internal metallic water pipe system, if present, are connected
together. This precaution may be particularly important in rural
areas.

Caution Users should not attempt to make such connections
themselves, but should contact the appropriate electric
inspection authority, or electrician, as appropriate.

Ringer equivRinger equivRinger equivRinger equivRinger equivalencealencealencealencealence

The Ringer Equivalence Number (REN) of this device is 0.6B.

Notice: The Ringer Equivalence Number (REN) assigned to each ter-
minal device provides an indication of the maximum number of termi-
nals allowed to be connected to a telephone interface. The termina-
tion on an interface may consist of any combination of devices subject
only to the requirement that the sum of the Ringer Equivalence Num-
bers of all the devices does not exceed 5. The equipment uses a CA11A
jack.


